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Nebraska Provider Quarterly Report Instructions

Purpose

These directions are for completing Provider Quarterly Incident Reports consistent with Nebraska’s Division of

Developmental Disabilities (DDD) regulations and Medicaid Home and Community-Based Services (HCBS) Waiver

guidelines:

* Nebraska Administrative Code Title 404 Regulations, 4-008.01, Section 5d: An aggregate report of
incidents must be submitted to the Department on a quarterly basis. Each report must be received by the
Department no later than 30 days after the last day of the previous quarter. The reports must include a
compilation, analysis, and interpretation of data, and include evidentiary examples to evaluate
performance that result in a reduction in the number of incidents over time.

* HCBS Waivers Appendix A, Section 7, b.i. (A.7.b.i.) and Appendix G-Quality Improvement: Health and
Welfare, Section b.i. (G.b.i.): Quarterly, providers submit a report to DDD detailing the incidents in the
quarter and actions taken both on a participant and provider wide level to address the issue and to
decrease the likelihood of future incidents. A summary of all the incidents and of the providers efforts are
compiled into a report reviewed quarterly by the Quality Improvement Committee (QIC). The QIC
determines the need for systemic follow-up and additional areas requiring probing and/or DDD
management intervention.

All agency providers are expected to complete reports consistently, as outlined in the schedule and directions
below, to demonstrate their compliance with state and federal regulations by improving the services they

provide.
Quarter: Quarter Data: Quarterly Report Due Date:
1* Quarter January — March April 30"
2" Quarter April —June July 30"
3" Quarter July — September October 30"
4™ Quarter October - December January 30"
Directions
1. Logon to Therap.
2. Open the Provider Report template in Therap.
3. Within the template, enter the provider name (Within the space provided and the footer), the reporting
quarter, and the start/end dates of the quarter.
4. Select Agency Reports from the Dashboard page.
5. Go tothe Report Library.
6. Type GER into the Report Name, then press the Search Tab.
7. Click on GER Report-Management Summary
8. Inthe Event Start date section, enter the first day of the Quarterly Reporting Period.
9. Inthe Event End Date, select the last date of the Quarterly Reporting Period.
10. Export to Excel
11. Select Enable Editing
12. Save the Excel report to your folder. NOTE: Go to Step *20 if you choose to develop the graphs manually. Go
to Step 23b if there were no high notification GERs for the quarter.
13. NOTE: Prior to completing steps 15-19 to run a Macro to auto-populate the graphs, you must first adjust your

trust settings in Excel by clicking the File tab, then selecting Options, Trust Center, Trust Center Settings,
Macro Settings, then if allowed by our agency, select Disable all macros with notification and click OK.
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The Trust Center contains security and privacy settings. These settings help keep your
computer secure. We recommend that you do not change these settings.
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Trust Center

Trusted Publishers
Macro Settings
Trusted Locations
() Disable all macros without notification
Trusted Documents

@ Disable all macros with notification

Trusted App Catalogs spragially signed macros

Add-ins () Enable all macros (not recommended; potentially dangerous code can run)

Developer Macro Settings
Macro Settings

[] Trust access to the VBA project object model

Protected View
Message Bar
External Content
File Block Settings

Privacy Options

14. This setting will allow you to be notified each time the Macro Report is viewed, so you can confirm the report

is a trusted source.
15. In Therap, open the spreadsheet titled “Provider Report Macro”.
16. Enable Content to open the folder and select Yes to trust the Macros.
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17. From the Home Tab of the Excel Ribbon of the Therap data report you ran in steps 7-12, Click on the View tab.
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18. Click on the Macros tab and select View Macros. NOTE: For earlier versions of Excel you will complete these
steps from the Developer Tab by Clicking Options from the File tab. Select Customize Ribbon in the left pane,
and then click the Developer check box under Main Tabs on the right side of the dialog box. Click OK.

19. Select Macro Data 2.xls Provider report and click on the Run tab.

20. The quarterly incident data will auto-populate the graphs.

NOTE: Instead of running the Macros, you may also create your own pivot graphs. From the Insert Tab,
Separately, insert Pivot Charts (Sheets 1-3) and a Pivot Table (Sheet 4) into your data Spreadsheet:

PAGE LAYOUT FORMULAS DATA REVIEW VIEW
Store

Shapes

SmartArt
ecommended Table | Pictures Online S

ivotTables Picture Screenshot

Tables Tllustrations

H3 - Je

18

Sheet 1/Pivot Chart 1***;

Drag fields between areas below:

Y FILTERS Il COLUMNS
Status v

Notification ... ¥

= ROWS 2 VALUES

Event Type v Count of For...

OtherEvent ~

Sheets 1-3

Bing Maps

B People Graph | Recommended
Chart

Add-ins Charts Sparklines Filters Links

N
PivotChart Line olumn Wi Slicer Timeline = Hyperlink Te

Create PivotChart ? =

Choose the data that you want to analyze
© Select a table or range
Table/Range: =

*) Use an external data source

Connection name:
Choose where you want the PivotChart to be placed
“) New Worksheet
@ Existing Worksheet
Location: | Sheet1!SHS3

Choose whether you want to analyze multiple tables

[7] Add this data to the Data Model
o)

\ v 4

N

Sheet 2/Pivot Chart 2***:

Drag fields between areas below:

Y FILTERS Hli

Status v

COLUMNS

Notification .. ¥

2. VALUES

Countof For... ¥

v = ROWS

Program Na... ¥
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Sheet3 /Pivot Chart 3***: Sheet4 /PIVOT TABLE 1***:
Drag fields between areas below: Y FILTERS Il COLUMNS
Y FILTERS Il COLUMNS Status v

Status = Notification ... ¥

Notification ... ¥

= ROWS 2. VALUES
= ROWS > VALUES Individual La... ¥ Count of For... ¥

Individual La... ¥ Count of For... ¥ Individual Fir... ¥

Event Type v

OtherEvent ~

**After clicking and dragging the information from the Pivot fields, Status is filtered to exclude deleted
events, Notification level is filtered to include only High notification events. Count of Forms is Form ID.

21. Copy and Paste the graphs from sheets 1-3 into the Provider Report template. The graph from sheet 4 will
not be pasted into the report, but can be used as you analyze the data.

22. In Section 1, Data Compilation, review the data graphs.

23. In Section 2, labeled Provider and Participant Data Analysis and Action Plans to address Incident Reduction or
Systemic Patterns, please type or write requested information for each shaded blank section of the incident
categories requiring analysis. (The tab button should be used when going to each blank section.) To enhance
your analysis, you can right click on any digit within the Excel report (see first screen-shot below) to view all
data for the chosen area to analyze if there are any trends or systemic patterns.

A B C
1 |Status (Multiple ltems) o
2 Notification Level |(Multiple ltems) o
3
4 Count of Form ID
5 |Event Type v | Other Event ¥ | Total
6 | =lInjury N/A 4
7 |Injury Total 4
8 | = Other Hospital
9 Law Enforcement Involvement 1
10 Sensitive Situation 1
11 Serious lliness 1
12 |Other Total 6
13 |Grand Total 10
14
15
16
17
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H - s
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aste . . - v|l=E==|e& 5= - - €0 .00 onditional Format as ell nsert Delete Format
v ~ Format Painter BIuU - - A === &= H Merge & Center $ % ¢ s Formatting~ Table~ Styles~ - -
Clipboard ] Font ] Alignment [P Number ] Styles Cells
H2 - fr | GER-JARVIS-F994W3VRDZAGU
A B C D E F G H |
1 |Individual Last Name Individual First Name Individual ID Number Program Name Program ID Site Name Site ID Form ID Status Event Dat
2 |Brown Jonathan Residential GER-JARVIS-F994W3VRDZAGBU Approved 07-07-2017
3 |Brown Jonathan Residential GER-JARVIS-F9K4PZZVCPKTT Approved 07-13-201%
4 |Bror Jonathan Residential GER-JARVIS-F9Z4PE8YT4M6N Approved 07-31-2011
5

a. After clicking on the incident entry number for the quarter within the spreadsheet, separately, review the
Program/Site, Individual Last Name, Individual First name, Event Date, Other Summary, What happened
before incident, Event Day, Event Time, columns to analyze if any trends or systemic patterns exist.

b. NOTE: Alphabetical sections B-T needing no analysis, as described in the table for the event category,
should be deleted and removed from your Provider Report. Systemic issues may include:
1. Asingle incident caused by employee actions or inactions,
2. orrepeated incidents impacted by procedures, limitations, or protocols.

Category boxes can be deleted, see screenshot below, by placing your cursor in the box, right clicking on
the small square appearing to the left upper corner of the box, then delete the table.

} 3 AWO

the quatr
or partic
24. Areas asking for analysis within Section 2 will include:
a.
Analysis:
ltem: Check all reasons for the additional analysis: If checked, explain reason(s):
1 There were three or more incidents for
the quarter.
2 A participant had three or more incidents.
3 This quarter’s total exceeded the prior
provider or participant total.
4 There were systemic issues.

Check and describe reason(s) for additional analysis. Examples of possible reasons include, but are not
limited to:

* The number of GER events exceeded the amounts listed within the template.

* The number of incidents increased from the prior quarter.

* The participant had (team-defined) number of incidents this quarter.

* There was a provider-wide problem causing an increase.
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List the specific nature or type of incidents.
b.

Action Plan to address Incident Reduction or Systemic patterns:

Explain, in detail, action plans that will be taken or already taken to address incidents for the participant
or provider, or list why additional action plans should not be implemented to address the analysis of the
incidents:

List action plans that will be taken or already taken to address incidents or systemic patterns for the
participant or provider. Possible examples may include:

* The team met for one participant and decided to revise his bus schedule times.

* The program will increase training and on-site assistance for staff this quarter.

* Increased on-site assistance and training for staff during incidents to increase the autonomy of
the staff and improve their ability to manage maladaptive behaviors at the initial stage to prevent
full participant escalation.

* Every employee will receive a refresher Behavioral Intervention course, which teaches nonviolent
crisis prevention.

This section may also include the reason(s) why additional actions to address the incident category should
not be implemented to address the incidents. Possible reasons include, but are not limited to:

* A participant left the provider’s service.

* Actions are not necessary because the number of incidents decreased significantly this quarter.

* No systemic trends were noted with the incidents.

High Notification GER Overview: Complete the template by filling in the shaded sections with the
requested information.
This quarter there were -high notification level General Event Reports (GERs), which
included - high level incidents and -participants. In comparison, there were -
High Notification GERs the prior quarter.

AWOL/Missing Person Incidents: Include additional analysis if there were three or more incidents for the
guarter, a participant had three or more incidents, this quarter’s total exceeded the prior provider or
participant total, or if there were systemic issues. In column 2, document the reason for your analysis,
then in the last column, describe specifically what occurred this quarter.

Analysis:
ltem: Check all reasons for the additional analysis: If checked, explain reason(s):
1 There were three or more incidents for
the quarter.
2 A participant had three or more incidents.
3 This quarter’s total exceeded the prior
provider or participant total.
4 There were systemic issues.
After clicking on the incident entry number for the quarter within the spreadsheet, see step 23,
review the Other Summary and What happened Before Incident columns and fill in the shaded
sections with the number of GER events:
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incidents involved missing persons, and

involved participants leaving supervision.

Action Plan to address Incident Reduction or Systemic Patterns:
Explain, in detail, action plans that will be taken or already taken to address incidents for the
participant or provider, or list why additional action plans should not be implemented to address

the analysis of the incidents:

C. Assault incidents: Include additional analysis if there were thirteen or more incidents for the quarter, a
participant had six or more incidents, this quarter’s total exceeded the prior provider or participant total,
or if there were systemic issues. In column 2, document the reason for your analysis, then in the last
column, describe specifically what occurred this quarter.

Analysis:
ltem: Check all reasons for the additional analysis: If checked, explain reason(s):
1 There were thirteen or more incidents for
the quarter.
A participant had six or more incidents.
This quarter’s total exceeded the prior
provider or participant total.
4 There were systemic issues.

After clicking on the incident entry number for the quarter within the spreadsheet, see step 23,
review the Altercation, Individual Involvement, Other Summary and What happened before
incident columns and fill in the shaded sections with the number of GER events:

consisted of peer to peer-related assaults.

of the assault incidents involved participants aggressing toward employees
who sought medical attention.

Action Plan to address Incident Reduction or Systemic patterns:
Explain, in detail, action plans that will be taken or already taken to address incidents for the
participant or provider, or list why additional action plans should not be implemented to address

the analysis of the incidents:

D. Altercation incidents: Include additional analysis if there were three or more incidents for the quarter, a
participant had two or more incidents, this quarter’s total exceeded the prior provider or participant total,
or if there were systemic issues. In column 2, document the reason for your analysis, then in the last
column, describe specifically what occurred this quarter.

Page 9 of 18



Nebraska Provider Quarterly Report Instructions

Analysis:
ltem: Check all reasons for the additional analysis: If checked, explain reason(s):
1 There were three or more incidents for
the quarter.
2 A participant had two or more incidents.
3 This quarter’s total exceeded the prior
provider or participant total.
4 There were systemic issues.

After clicking on the incident entry number for the quarter within the spreadsheet, see step 23,
review the Altercation, Individual Involvement, Other Summary and What happened before
incident columns and fill in the shaded sections with the number of GER events:

consisted of peer to peer related incidents
of the assault incidents involved altercations with someone other than another
participant.

Action Plan to address Incident Reduction or Systemic patterns:
Explain, in detail, action plans that will be taken or already taken to address incidents for the
participant or provider, or list why additional action plans should not be implemented to address

the analysis of the incidents:

E. Complaints and/or possible litigation incidents (abuse/neglect/exploitation): Include additional analysis if

there were any incidents for the quarter, or if there were systemic issues. In column 2, document the
reason for your analysis, then in the last column, describe specifically what occurred this quarter.

Analysis:
ltem: Check all reasons for the additional analysis: If checked, explain reason(s):
1 There were incidents for the quarter.
2 There were systemic issues.

Fill in the shaded sections with the number of GER events to complete your analysis:

of these reports were turned over to APS, and not investigated internally. This was due
to

complaints were investigated internally.

were found to be unsubstantiated for abuse/neglect.
were found to be substantiated abuse.

were found to be substantiated neglect.

were found to be substantiated exploitation.
Appropriate personnel action, including

was taken in all substantiated cases.
were reported appropriately.
were investigated properly.
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Action Plan to address Incident Reduction or Systemic patterns:
Explain, in detail, action plans that will be taken or already taken to address incidents for the
participant or provider, or list why additional action plans should not be implemented to address

the analysis of the incidents:

F. Deaths: Include additional analysis if there were any incidents for the quarter, or if there were systemic
issues. In column 2, document the reason for your analysis, then in the last column, describe specifically
what occurred this quarter.

Analysis:
ltem: Check all reasons for the additional analysis: If checked, explain reason(s):
1 There were incidents for the quarter.
2 There were systemic issues.

Fill in the shaded sections with the number of GER events to complete your analysis:

deaths were investigated internally.
deaths were reported to DHHS.
deaths were investigated by DPH.
deaths were reported appropriately.
were found to be substantiated abuse.

were found to be substantiated neglect.

Action Plan to address Incident Reduction or Systemic patterns:

Explain, in detail, action plans that will be taken or already taken to address incidents for the
participant or provider, or list why additional action plans should not be implemented to address
the analysis of the incidents:_

G. Emergency Safety Intervention Incidents: include additional analysis if there were any incidents for the
quarter, or if there were systemic issues.

Analysis:
ltem: Check all reasons for the additional analysis: If checked, explain reason(s):
1 There were incidents for the quarter.
2 There were systemic issues.

Fill in the shaded sections with the number of GER events to complete your analysis:

of the interventions were approved.

of the interventions were reported as abuse or neglect.

injuries related to Emergency Safety Interventions occurred.

of the interventions were part of a safety plan.

of the interventions were unplanned and not part of a safety plan.

Action Plan to address Incident Reduction or Systemic patterns:
Explain, in detail, action plans that will be taken or already taken to address incidents for the
participant or provider, or list why additional action plans should not be implemented to address

the analysis of the incidents:
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H. Restraint Other GER Incidents: Include additional analysis if there were any incidents for the quarter, or if
there were systemic issues.

Analysis:
ltem: Check all reasons for the additional analysis: If checked, explain reason(s):
1 There were incidents for the quarter.
2 There were systemic issues.

Fill in the shaded sections with the number of GER events to complete your analysis:

of the restraint incidents involved the use of chemical restraint,

of the restraint incidents involved the use of mechanical restraint,
of the restraint incidents involved the use of physical restraint, and
of the restraint incidents involved the use of

\ Describe:

of the interventions were reported as abuse or neglect.

of the interventions reported as abuse or neglect were investigated in
accordance with 175 Nebraska Administrative Code 19-006.02#6.
injuries related to Restraint occurred.

Action Plan to address Incident Reduction or Systemic patterns:
Explain, in detail, action plans that will be taken or already taken to address incidents for the
participant or provider, or list why additional action plans should not be implemented to address

the analysis of the incidents:

I.  Hospital Incidents: Include additional analysis if there were eleven or more incidents for the quarter, a
participant had three or more incidents, this quarter’s total exceeded the prior provider or participant
total, or if there were systemic issues. In column 2, document the reason for your analysis, then in the last
column, describe specifically what occurred this quarter.

Analysis:
ltem: Check all reasons for the additional analysis: If checked, explain reason(s):
1 There were eleven or more incidents for
the quarter.
2 A participant had three or more incidents.
3 This quarter’s total exceeded the prior
provider or participant total.
4 There were systemic issues.

Fill in the shaded sections with the number of GER events to complete your analysis:

of the admission incidents were for mental health reasons.
of the admission incidents were for physical health hospital admissions
incidents.

Action Plan to address Incident Reduction or Systemic patterns:
Explain, in detail, action plans that will be taken or already taken to address incidents for the
participant or provider, or list why additional action plans should not be implemented to address

the analysis of the incidents:
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J. High notification level injury incidents: Include additional analysis if there were sixteen or more incidents
for the quarter, a participant had four or more incidents, this quarter’s total exceeded the prior provider
or participant total, or if there were systemic issues. In column 2, document the reason for your analysis,
then in the last column, describe specifically what occurred this quarter.

Analysis:
ltem: Check all reasons for the additional analysis: If checked, explain reason(s):
1 There were sixteen or more incidents for
the quarter.
2 A participant had four or more incidents.
3 This quarter’s total exceeded the prior
provider or participant total.
4 There were systemic issues.

After clicking on the incident entry number for the quarter within the spreadsheet, see step 23,
review the injury type, injury cause, injury severity columns and fill in the shaded sections with the
number of GER events:

of these injuries required no treatment,

of them were minor, requiring basic first aid,

of them were moderate, requiring nurse or physician treatment. Finally,
of the injuries were severe, requiring an emergency room visit, with or
without admission.

injuries were related to emergency safety interventions,

were of unknown origin, and

injuries were due to displacement due to fires.

injuries required medical attention to staff persons and others resulting from
the behavior of a participant.

The leading causes of injuries were

Action Plan to address Incident Reduction or Systemic patterns:
Explain, in detail, action plans that will be taken or already taken to address incidents for the
participant or provider, or list why additional action plans should not be implemented to address

the analysis of the incidents: [

K. Falls with injury: Include additional analysis if a participant had two or more incidents, this quarter’s total

exceeded the prior provider or participant total, or if there were systemic issues. In column 2, document
the reason for your analysis, then in the last column, describe specifically what occurred this quarter.

Analysis:
ltem: Check all reasons for the additional analysis: If checked, explain reason(s):
1 A participant had two or more incidents.
2 This quarter’s total exceeded the prior
provider or participant total.
3 There were systemic issues.
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After clicking on the incident entry number for the quarter within the spreadsheet, see step 23,
review the injury type, injury cause, injury severity columns and fill in the shaded sections with
the number of GER events:

falls with injury occurred this quarter.

required no treatment.

of these injuries required minor first aid,

were moderate, requiring nurse or physician treatment.
were severe, requiring hospital/ER treatment.

Action Plan to address Incident Reduction or Systemic patterns:
Explain, in detail, action plans that will be taken or already taken to address incidents for the
participant or provider, or list why additional action plans should not be implemented to address

the analysis of the incidents:

L. Law enforcement incidents: Include additional analysis if there were any incidents for the quarter, a
participant had six or more incidents, this quarter’s total exceeded prior provider or participant
total/averages, or if there were systemic issues. In column 2, document the reason for your analysis,
then in the last column, describe specifically what occurred this quarter.

Analysis:
ltem: Check all reasons for the additional analysis: If checked, explain reason(s):
1 There were incidents for the quarter.
2 A participant had six or more incidents.
3 This quarter’s total exceeded the prior
provider or participant total.
4 There were systemic issues.

After clicking on the incident entry number for the quarter within the spreadsheet, see step 23,
review the other summary and what happened before incident columns and fill in the shaded
sections with the number of GER events:

law enforcement events occurred this this quarter.

participants were involved with the law enforcement events this quarter.
law enforcement contact incidents were called in by the participant,
were called in by the provider, and

were called by someone from the community.

Action Plan to address Incident Reduction or Systemic patterns:
Explain, in detail, action plans that will be taken or already taken to address incidents for the
participant or provider, or list why additional action plans should not be implemented to address

the analysis of the incidents: [

M. Medication error incidents: Include additional analysis if there were two or more incidents for the
quarter, or if there were systemic issues. In column 2, document the reason for your analysis, then in the
last column, describe specifically what occurred this quarter.
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Analysis:
ltem: Check all reasons for the additional analysis: If checked, explain reason(s):
1 There were two or more incidents for the
quarter.
2 There were systemic issues.

Fill in the shaded sections with the number of GER events to complete your analysis:

high notification level medication error incidents occurred this quarter.
medication errors resulted in injury,

resulted in serious illness, and

resulted in hospitalization.

Action Plan to address Incident Reduction or Systemic patterns:
Explain, in detail, action plans that will be taken or already taken to address incidents for the
participant or provider, or list why additional action plans should not be implemented to address

the analysis of the incidents:

N. Possible criminal activity Incidents: Include additional analysis if there were any incidents for the quarter,
a participant had two or more incidents, this quarter’s total exceeded prior provider or participant
total/averages, or if there were systemic issues. In column 2, document the reason for your analysis,
then in the last column, describe specifically what occurred this quarter.
Analysis:*Include analysis if any items in column 2 of the table below are checked:

ltem: Check all reasons for the additional analysis: If checked, explain reason(s):
1 There were incidents for the quarter.
2 A participant had two or more incidents.
3 This quarter’s total exceeded the prior
provider or participant total.
4 There were systemic issues.

Fill in the shaded sections with the number of GER events to complete your analysis:

participants were involved in criminal involvement incidents this quarter.

provider employees were involved in criminal involvement incidents this
quarter.

other people were suspected of engaging in criminal activity involving
participants.

Action Plan to address Incident Reduction or Systemic patterns:
Explain, in detail, action plans that will be taken or already taken to address incidents for the
participant or provider, or list why additional action plans should not be implemented to address

the analysis of the incidents: [
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O. Property damage high notification incidents: Include additional analysis if there were three or more
incidents for the quarter, a participant had five or more incidents, this quarter’s total exceeded the prior
provider or participant total, or if there were systemic issues. In column 2, document the reason for your
analysis, then in the last column, describe specifically what occurred this quarter.

Analysis: *Include analysis if any items in column 2 of the table below are checked:

ltem: Check all reasons for the additional analysis: If checked, explain reason(s):

1 There were three or more incidents for
the quarter.

2 A participant had five or more incidents.

3 This quarter’s total exceeded the prior
provider or participant total.

4 There were systemic issues.

Fill in the shaded sections with the number of GER events to complete your analysis:
High notification property damage incidents caused by participants occurred
this quarter.

High notification property damage incidents caused by staff occurred this
quarter.

Action Plan to address Incident Reduction or Systemic patterns:
Explain, in detail, action plans that will be taken or already taken to address incidents for the
participant or provider, or list why additional action plans should not be implemented to address

the analysis of the incidents: [

P. Seizure high notification incidents: Include additional analysis if there were two or more incidents for the

quarter, or if there were systemic issues. In column 2, document the reason for your analysis, then in the
last column, describe specifically what occurred this quarter.

Analysis: *Include analysis if any items in column 2 of the table below are checked:

ltem: Check all reasons for the additional analysis: If checked, explain reason(s):
1 There were two or more incidents for the

quarter.
2 There were systemic issues.

Fill in the shaded sections with the number of GER events to complete your analysis:
high notification seizure incidents occurred this quarter.
resulted in hospitalizations.

Action Plan to address Incident Reduction or Systemic patterns:
Explain, in detail, action plans that will be taken or already taken to address incidents for the
participant or provider, or list why additional action plans should not be implemented to address

the analysis of the incidents:

Q. Serious illness incidents: Include additional analysis if there were any incidents for the quarter, or if there

were systemic issues. In column 2, document the reason for your analysis, then in the last column,
describe specifically what occurred this quarter.
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Analysis: *Include analysis if any items in column 2 of the table below are checked:

ltem: Check all reasons for the additional analysis: If checked, explain reason(s):
1 There were incidents for the quarter.
2 There were systemic issues.

Fill in the shaded sections with the number of GER events to complete your analysis:
incidents were the result of medication errors.
resulted in hospitalizations.

Action Plan to address Incident Reduction or Systemic patterns:
Explain, in detail, action plans that will be taken or already taken to address incidents for the
participant or provider, or list why additional action plans should not be implemented to address

the analysis of the ncidents

R. List any GER incidents not previously listed above. Include totals and any additional analysis. These need

to be addressed in action plans since high notification was used for incidents not listed in the GER
Instruction Guide Reportable Incident List.

Analysis:

Fill in the shaded sections with the number of GER events to complete your analysis:
incidents were reported in the Therap category. (Repeat as needed)
incidents were reported in the Therap category. (Repeat as needed)
incidents were reported in the Therap category. (Repeat as needed)

Action Plan to address Incident Reduction or Systemic patterns:
Explain, in detail, action plans that will be taken or already taken to address incidents for the
participant or provider, or list why additional action plans should not be implemented to address

the analysis of the ncidents

S. Enter the number of participants with more than 4 high GERs.
Analysis:

Fill in the shaded sections with the number of GER events to complete your analysis:

Action Plan to address Incident Reduction or Systemic patterns:
Explain, in detail, action plans that will be taken or already taken to address incidents for the
participant or provider, or list why additional action plans should not be implemented to address

the analysis of the ncidents [

T. Include any trends noted for the participants. Trends may include events occurring within multiple high
notification GER categories or patterns over-lapping GER incident categories.

T. Fill in the shaded sections to complete your analysis:

Participant trends included....

Analysis:

Action Plan to address Incident Reduction or Systemic patterns:
Explain, in detail, action plans that will be taken or already taken to address incidents for the
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participant or provider, or list why additional action plans should not be implemented to address

the analysis of the incidents:

c. InSection 3, labeled Data Interpretation, complete the information as listed within the template.
Fill in the shaded sections to complete your analysis:

a. The overall incident Increase/Decrease is possibly due to
Additional actions to address the overall incident increase are/are not needed because

c. Reporting of incidents to provider management, the participant, family member/legal
representative (As appropriate), the Service Coordinator, CPS/APS and Law Enforcement

as appropriate was completed properly and timely for of GER
incidents.

d. GERs were approved properly and timely, based on the Report Date and Approve Date
Columns of the Excel GER Management Summary Report, for of
GER incidents.

e. Notification levels for GERs were initially completed properly for of
GERs.

f. GERs were completed, based on the Event Date and Report Date Columns of the Excel GER
Management Summary Report, within required timelines for of
GER incidents.

g. Corrective actions, based on the Corrective Action Taken and Plan of Future Action
Columns of the Excel GER Management Summary Report were taken for of
GER incidents.

Action Plan to address Incident Reduction or Systemic patterns:
Explain, in detail, action plans that will be taken or already taken to address incidents for the
participant or provider, or list why additional action plans should not be implemented to address

the analysis of the incidents:

d. Sign or list the name(s) and title(s) of those completing the report.
€. When finished, e-mail a PDF version or scan a copy of your Provider Report to
DHHS.DDCBSQl@nebraska.gov

Quarter: Quarter Data: Quarterly Report Due Date:
1* Quarter January — March April 30"

2" Quarter April —June July 30"

3" Quarter July — September October 30"

4™ Quarter October - December January 30"
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